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How Do I?
Learn how to use your HP Deskjet 2520 series
•
•
•
•
•

Printer parts
Copy documents or photos
Load media
Replace the cartridges
Clear a paper jam
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Get to know the HP Deskjet 2520 series
•
•
•

Printer parts
Control panel features
Status lights

1

Input tray

2

Input tray guard

3

Paper-width guide for the input tray

4

Control panel

5

Cartridge door

6

Output tray

7

Output tray extender (also referred to as the tray extender)

8

Cartridges
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Control panel features
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1

Power: Turns the product on or off. When the product is off, a minimal amount of power is still used. To completely
remove power, turn off the product, then unplug the power cord. See Status lights for more information.

2

Scan: Initiates a front panel scan job after connection to computer has been established.

3

Cancel: Stops the current operation.

4

Fit to page: Enlarges or reduces the original placed on the glass.

5

Fit to page light: Indicates whether the enlarge or reduce function has been selected.

6

Start Copy Black: Starts a black-and-white copy job. Increase the number of copies by pressing the button multiple
times. Acts as a resume button after resolving print problems.

7

Start Copy Color: Starts a color copy job. Increase the number of copies by pressing the button multiple times. Acts as a
resume button after resolving print problems.

8

Attention light: Indicates that there is a paper jam, the printer is out of paper, or some event that requires your attention.

9

Control panel display: Indicates the number of copies, media error, ink level, and ink error.

Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-Off is
enabled, the printer will automatically turn off after two hours of inactivity to help reduce energy use. See Auto
Power-Off for more information.

Status lights
When the product is turned on, the power button light will be lit. When the product is processing a job, the power
light will be blinking. Additional blinking lights signal errors that you can resolve. See below to learn about blinking
lights and what to do.
Behavior

Cause and solution

Power light is blinking and attention light is on.

Output tray closed when printing is attempted.
Open output tray.
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(continued)
Behavior

Cause and solution

Power light, ink levels, and attention light are blinking.

Ink access door is open.
See Prepare the trays.

Both ink level icons are blinking.

Both cartridges are missing, or do not have the
tape removed, or may be defective.

One ink level icon is blinking.

Get to know the
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Install cartridges, or remove the pink tape from
the cartridges, or replace the defective cartridges.
See Replace the cartridges for more information.

Blinking icon indicates corresponding cartridge is
missing, or does not have the tape removed, or
may be defective. The printer will print in singlecartridge mode with one cartridge.
Install missing black or color cartridge, or remove
the pink tape from the cartridge, or replace the
defective cartridge.

Letter "P", media icon, and attention light are blinking.

There is no paper, or paper is not feeding.
Load paper, then press any button, except
Cancel, to resume printing. See Load media.

Letter "J", media icon, and attention light are blinking.

There is a paper jam.
See Clear a paper jam. Load paper, then press
any button, except Cancel, to resume printing.

Letter "C", ink level icons, and attention light are blinking.

Cartridge carriage inside printer has stalled.
Open cartridge door and make sure carriage is
not obstructed. Move carriage to the right, close
door, and then press any button, except Cancel,
to resume.

Power light, media icon, and attention light are blinking.

Scanner is not working. Press Power button to
turn printer off, and then on again.
If problem persists, contact HP. Printer will still
print even if scanner is not working.

Status lights
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(continued)
Behavior

Cause and solution

Power light, letter "E", media icon, ink level icons, ink drop icon, and
attention light are blinking.

Printer is in an error state.
Reset printer.
1.
2.
3.
4.

Turn printer off.
Unplug power cord.
Wait a minute, plug power cord back in.
Turn on printer.

If problem persists, contact HP.
One ink level icon and ink drop icon are blinking, and the attention light is
on.

Blinking ink level icon indicates that
corresponding cartridge has a problem. Cartridge
may be improperly installed, incompatible,
counterfeit or very low on ink.

•
•
•
Get to know the
HP Deskjet 2520 series

•
•
Both ink level icons and ink drop icon are blinking, and the attention light
is on.

Both cartridges have a problem. Cartridges may
be improperly installed, incompatible, defective,
counterfeit or very low on ink.

•
•
•
•
•
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If you see a message on your computer
screen, refer to the message for more
information about the problem.
If there is no message on your computer
screen, try removing and reinserting the
cartridge.
Confirm that you are using the correct HP
cartridge for your printer.
Determine if the cartridge is defective. See
Identify a defective cartridge.
If print quality is poor, consider replacing
the cartridge. See Replace the cartridges.

If you see a message on your computer
screen, refer to the message for more
information about the problem.
If there is no message on your computer
screen, try removing and reinserting the
cartridges.
Confirm that you are using the correct HP
cartridges for your printer.
Determine if a cartridge is defective. See
Identify a defective cartridge.
If print quality is poor, consider replacing
the cartridges. See Replace the cartridges.
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Print
Choose a print job to continue.

Print documents

Print photos

Print envelopes

Print documents

Print

To print from a software application
1.
Make sure the output tray is open.
2.
Make sure you have paper loaded in the input tray.

3.
4.
5.

6.

7.
8.

See Load media for more information.
From your software application, click the Print button.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.
Select the appropriate options.
•
On Layout tab select Portrait or Landscape orientation.
•
On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down
list.
•
Click Advanced to select the appropriate paper size from the Paper/Output list.
Click OK to close the Properties dialog box.
Click Print or OK to begin printing.

Print
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NOTE: You can print your document on both sides of the paper, instead of just one side. Click on the
Advanced button on the Paper/Quality or Layout tab. From the Pages to Print drop-down menu select
Print Even Pages Only. Click OK to print. After the even numbered pages of the document have been
printed, remove the document from the output tray. Reload the paper in the input tray with the blank side up,
and top of page down. Return to the Pages to Print drop-down menu and then select Print Odd Pages
Only. Click OK to print.

Print photos
To print a photo on photo paper
1.
Make sure the output tray is open.
2.
Remove all paper from the input tray, and then load the photo paper print side up.
NOTE: If the photo paper you are using has perforated tabs, load photo paper so that tabs are on top.

3.
4.
5.

Print

6.
7.

See Load media for more information.
On the File menu in your software application, click Print.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.
Click the Paper/Quality tab.
Select the appropriate options.
•
On Layout tab select Portrait or Landscape orientation.
•
On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down
list.
•
Click Advanced to select the appropriate paper size from the Paper/Output list.
NOTE: For maximum dpi resolution, go to the Paper/Quality tab and select Photo Paper, Best
Quality from the Media drop-down list. Make sure you are printing in color. Then click the Advanced
button and select Yes from the Print in Max DPI drop-down list. For more information, see Print using
the maximum dpi.

8.
9.

Click OK to return to the Properties dialog box.
Click OK, and then click Print or OK in the Print dialog box.
NOTE: Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce
the quality of your printout. Photo paper should be flat before printing.

Print envelopes
You can load one or more envelopes into the input tray of the HP Deskjet 2520 series. Do not use shiny or
embossed envelopes or envelopes that have clasps or windows.
10
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NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your word
processing software. For best results, consider using a label for the return address on envelopes.
To print envelopes
1.
Make sure the output tray is open.
2.
Slide the paper guide all the way to the left.
3.
Place the envelopes in the right side of the tray. The side to be printed on should face up. The flap should
be on the left side.
4.
Push the envelopes into the printer until they stop.
5.
Slide the paper guide firmly against the edge of the envelopes.

6.

7.

8.

See Load media for more information.
Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.
Select the appropriate options.
•
On Paper/Quality tab select the appropriate type from the Media drop-down menu.
•
Click the Advanced button, and select the appropriate envelope size from the Paper Size drop-down
menu.
Click OK, and then click Print or OK in the Print dialog box.
Print

Tips for print success
To successfully print, the HP cartridges should be functioning properly with sufficient ink, the paper should be
loaded correctly, and the product should have the appropriate settings.
Cartridge tips
•
Use genuine HP ink cartridges.
•
Install both the black and tri-color cartridges correctly.
For more information, see Replace the cartridges.
•
Check the estimated ink levels in the cartridges to make sure there is sufficient ink.
For more information, see Check the estimated ink levels.
•
For more information, see Improve print quality.
Paper loading tips
•
Load a stack of paper (not just one page). All of the paper in the stack should be the same size and type to
avoid causing a paper jam.
•
Load paper with the side to be printed on facing up.
•
Ensure that paper loaded in the input tray lies flat and the edges are not bent or torn.
•
Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width
guide does not bend the paper in the input tray.
•
For more information, see Load media.
Tips for print success
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Printer settings tips
•
On the Paper/Quality tab of the print driver, select the appropriate paper type and quality from the Media
drop down menu.
•
Click the Advanced button, and select the appropriate paper size from the Paper Size drop-down menu.
•
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.
NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series
Notes
•
Genuine HP ink cartridges are designed and tested with HP printers and papers to help you easily produce
great results, time after time.
NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs
required as a result of using a non-HP supply will not be covered under warranty.
If you believe you purchased genuine HP ink cartridges, go to:
www.hp.com/go/anticounterfeit
•

Ink level warnings and indicators provide estimates for planning purposes only.
NOTE: When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace the cartridges until print quality
becomes unacceptable.

•
•

Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.
You can print your document on both sides of the paper, instead of just one side.
NOTE: Click the Advanced button on the Paper/Quality or Layout tab. From the Pages to Print
drop-down menu select Print Odd Pages Only. Click OK to print. After the odd numbered pages of the
document have been printed, remove the document from the output tray. Reload the paper in the input
tray with the blank side facing up. Return to the Pages to Print drop-down menu and then select Print
Even Pages Only. Click OK to print.

•

Print using black ink only

Print

NOTE: If you want to print a black and white document using black ink only, click the Advanced
button. From the Print in Grayscale drop-down menu select Black Ink Only, then click the OK button.
If you see Black and White as an option on the Paper/Quality tab or the Layout tab, select it.

Print using the maximum dpi
Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.
See technical specifications for the print resolution of the maximum dpi mode.
Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.
To print in Maximum dpi mode
1.
Make sure you have photo paper loaded in the input tray.
2.
On the File menu in your software application, click Print.
3.
Make sure the product is the selected printer.
4.
Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.
5.
Click the Paper/Quality tab.
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6.

In the Media drop-down list, click Photo Paper, Best Quality.
NOTE: Photo Paper, Best Quality must be selected from the Media drop-down list on the Paper/
Quality tab to enable printing in maximum DPI.
Click the Advanced button.
In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
Select Paper Size from Paper/Output drop-down menu.
Click OK to close the advanced options.
Confirm Orientation on Layout tab, then click OK to print.

Print

7.
8.
9.
10.
11.

Print using the maximum dpi
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Paper basics
You can load many different types and sizes of paper in the HP Deskjet 2520 series, including letter or A4 paper,
photo paper, transparencies, and envelopes.
This section contains the following topics:
•
•

Recommended papers for printing
Load media

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of
project you are printing.
Depending on your country/region, some of these papers might not be available.
ColorLok
•
HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All
papers with the ColorLok logo are independently tested to meet high standards of reliability and print
quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper
manufacturers.

HP Everyday Photo Paper
•
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This
affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper
with any inkjet printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10
x 15 cm (4 x 6 inch) (with or without tabs). For longer-lasting photos, it is acid-free.
HP Brochure Paper or HP Superior Inkjet Paper
•
These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect
choice for near-photographic reproductions and business graphics for report covers, special presentations,
brochures, mailers, and calendars.
HP Premium Presentation Paper or HP Professional Paper
•
These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and
newsletters. They are heavyweight for an impressive look and feel.

Paper basics
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HP Advanced Photo Paper
•
This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water,
smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo.
It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x
18 cm (5 x 7 inch), and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting
documents.

Chapter 4

HP Bright White Inkjet Paper
•
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided
color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features
ColorLok Technology for less smearing, bolder blacks, and vivid colors.
HP Printing Paper
•
HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more
substantial than documents printed on standard multipurpose or copy paper. It features ColorLok
Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.
HP Office Paper
•
HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other
everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It
is acid-free for longer lasting documents.
HP Iron-On Transfers
•
HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom
T-shirts from your digital photos.
HP Premium Inkjet Transparency Film
•
HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This
film is easy to use and handle and dries quickly without smudging.
HP Photo Value Pack
•
HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save
you time and take the guesswork out of printing affordable professional photos with your
HP Deskjet 2520 series. Original HP inks and HP Advanced Photo Paper have been designed to work
together so your photos are long lasting and vivid, print after print. Great for printing out an entire vacation’s
worth of photos or multiple prints to share.
NOTE: At this time, some portions of the HP Web site are available in English only.
To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted, choose your country/
region, follow the prompts to select your product, and then click one of the shopping links on the page.

Load media
▲

Select a paper size to continue.

Paper basics

Load full-size paper
a.
Raise the input tray
❑ Raise the input tray.

b.
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Lower the output tray
❑ Lower the output tray and pull out the tray extender.

c.

Slide paper-width guide to the left
❑ Slide paper-width guide to the left.

d.

Load paper.
❑ Insert stack of paper into input tray with short edge forward and print side up.

Slide stack of paper down until it stops.
Slide paper-width guide to the right until it stops at edge of paper.

Paper basics

❑
❑

Load small-size paper
a.
Raise the input tray
❑ Raise the input tray.
Load media
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Lower the output tray
❑ Lower the output tray and pull out the tray extender.

c.

Slide paper-width guide to the left.
❑ Slide paper-width guide to the left.

d.

Load paper.
❑ Insert stack of photo paper with short edge down and print side up.
❑ Slide stack of paper forward until it stops.

Paper basics

b.

NOTE: If the photo paper you are using has perforated tabs, load photo paper so that tabs
are on top.
❑
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Slide paper-width guide to the right until it stops at edge of paper.

b.

Lower the output tray
❑ Lower the output tray and pull out the tray extender.

c.

Slide paper-width guide to the left.
❑ Slide paper-width guide to the left.

d.

❑ Remove all paper from the main input tray.
Load envelopes.
❑ Insert one or more envelopes into far-right side of the input tray. The side to be printed on should
face up. The flap should be on the left side and facing down.
❑ Slide stack of envelopes down until it stops.
❑ Slide paper-width guide to the right against stack of envelopes until it stops.

Load media
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Load envelopes
a.
Raise the input tray
❑ Raise the input tray.

Chapter 4

Paper basics
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Copy and scan
•
•
•
•

Copy documents or photos
Scan to a computer
Tips for copy success
Tips for scan success

Copy and scan

5

Copy documents or photos
NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality
when copying.
▲

Do one of the following:
1-sided original to 1-sided copy
a.
Load paper.
❑ Load either small photo paper or full-size paper in the input tray.

b.

Load original.
❑ Lift lid on product.

❑

Load original print side down on right front corner of glass.

Copy and scan
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Copy and scan

c.

❑ Close lid.
Start copy.
❑ Press Fit to Page to enlarge or reduce the original.
❑ Press either Start Copy Black or Start Copy Color. Increase the number of copies by pressing
the button multiple times.

Scan to a computer
NOTE: To scan to a computer, the HP Deskjet 2520 series and computer must be connected and turned on.
▲

To scan to a computer:
Single page scan
a.
Load original.
❑ Lift lid on product.

❑

22
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Load original print side down on right front corner of glass.

Copy and scan

❑

b.

Close lid.

Start scan.
❑ Start the scan job by either pressing Scan on the control panel or using the Printer Software.
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.
NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP
Deskjet 2520 series > HP Deskjet 2520 series
❑

Select Scan a Document or Photo. You will see scan options that you can select onscreen.

Tips for copy success
•

Load your original print side down on the right front corner of the glass.

Tips for copy success
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•

Press Fit to Page to enlarge or reduce the original image to fit the paper size on which you are printing.

Copy and scan

Click here to go online for more information.

Tips for scan success
•

Load your original print side down on the right front corner of the glass.

•

Clean the scanner glass and make sure that there are no foreign materials adhering to it.
Click here to go online for more information.
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Work with cartridges
•
•
•
•
•

Check the estimated ink levels
Order ink supplies
Replace the cartridges
Use single-cartridge mode
Cartridge warranty information

Work with cartridges

Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink
supply level shows an estimate of the amount of ink remaining in the cartridges.
The printer's control panel display shows the estimated ink level directly. Refer to the below instructions for
checking the detailed information about estimated ink level.
To check the ink levels from the Printer Software
1.
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.
NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series
2.

In the Printer Software, click Estimated Ink Levels.
NOTE: 1 If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in
another printer, the ink level indicator might be inaccurate or unavailable.
NOTE: 2 Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low-ink warning message, consider having a replacement cartridge available to avoid possible printing
delays. You do not have to replace the cartridges until the print quality is unacceptable.
NOTE: 3 Ink from the cartridges is used in the printing process in a number of different ways, including in the
initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which
keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Order ink supplies
Before ordering cartridges, locate the correct cartridge number.
Locate the cartridge number on the printer
▲ The cartridge number is located inside the cartridge door.

Work with cartridges
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Locate the cartridge number in the Printer Software
1.
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.
NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series
2.

In the Printer Software, click Shop and then click Shop For Supplies Online. The correct cartridge number
will be automatically displayed when you use this link.

To order genuine HP supplies for the HP Deskjet 2520 series, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one of the shopping links on
the page.
Work with cartridges

NOTE: Ordering cartridges online is not supported in all countries/regions. If it is not available in your
country/region, you may still view supplies information and print a list for reference when shopping at a local
HP reseller.
Related topics
•
Choose the right cartridges

Choose the right cartridges
HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP
printers to help you easily produce great results, time after time.
Related topics
•
Order ink supplies

Replace the cartridges
To replace the cartridges
1.
Check power.
2.
Load paper.
3.
Remove cartridge.
a.
Open cartridge door.

b.

26

Wait for print carriage to move to center of the product.
Press down to release cartridge, then remove it from slot.

Work with cartridges

5.

Insert new cartridge.
a.
Remove cartridge from packaging.

b.

Remove plastic tape using pink pull tab.

c.

Slide cartridge into slot until it clicks into place.

d.

Close cartridge door.

Work with cartridges

4.

Align cartridges.

Replace the cartridges
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Use single-cartridge mode
Use the single-cartridge mode to operate the HP Deskjet 2520 series with only one print cartridge. The singlecartridge mode is initiated when a print cartridge is removed from the print cartridge carriage. During singlecartridge mode, the product can copy documents, copy photos, and print jobs from the computer.
NOTE: When the HP Deskjet 2520 series operates in single-cartridge mode, a message is displayed on
screen. If the message is displayed and two print cartridges are installed in the product, verify that the
protective piece of plastic tape has been removed from each print cartridge. When plastic tape covers the
print cartridge contacts, the product cannot detect that the print cartridge is installed.
Work with cartridges

Exit single-cartridge mode
Install two print cartridges in the HP Deskjet 2520 series to exit single-cartridge mode.
Related topics
•
Replace the cartridges

Cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This
warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or
tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty
date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the product as
indicated:

For a copy of the HP Limited Warranty Statement for the printer, see the printed documentation that came with
the product.
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Connectivity
•
•

USB Connection (non-network connection)
Connect a new printer

USB Connection (non-network connection)
The HP Deskjet 2520 series supports a rear USB 2.0 High Speed port for connection to a computer.
To connect the product with the USB cable
▲ Refer to the setup instructions that came with your product for information on connecting to a computer with
a USB cable.
NOTE: Do not connect the USB cable to the product until you are prompted to do so.
If the printer software has been installed, the printer will operate as a plug and play device. If the software has not
been installed, insert the CD that came with the device and follow the onscreen instructions.

Connect a new printer
Connectivity

If you have already installed the printer software on your computer, but have not yet connected your printer, do
the following:
Connect a new printer
1.
From the computer’s start menu select All Programs or Programs, and then select HP.
2.
Select HP Deskjet 2520 series.
3.
Select Printer Setup & Software.
4.
Select Connect a new printer. Follow the onscreen instructions.

Connectivity
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Solve a problem
This section contains the following topics:
•
•
•
•

Improve print quality
Clear a paper jam
Unable to print
HP support

Improve print quality
1.
2.
3.
4.

Make sure you are using genuine HP cartridges.
Check the Printer Software settings to make sure you have selected the appropriate paper type and print
quality from the Media drop-down list.
Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see
Check the estimated ink levels. If the print cartridges are low on ink consider replacing them.
Align the printer cartridges.
To align the cartridges from the Printer Software
NOTE: Aligning the cartridges ensures high-quality output. The HP All-in-One prompts you to align the
cartridges every time you install a new cartridge. If you remove and reinstall the same print cartridge, the
HP All-in-One will not prompt you to align the print cartridges. The HP All-in-One remembers the
alignment values for that print cartridge, so you do not need to realign the print cartridges.

5.

Load letter or A4 unused plain white paper into the input tray.
In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP
Deskjet 2520 series Toolbox.
c.
The HP Deskjet 2520 series Toolbox appears.
d.
Click the Device Services tab.
e.
Click Align Ink Cartridges tab. The product prints an alignment sheet.
f.
Load the cartridge alignment sheet print side down on the right front corner of the glass.
g.
Press the Start Copy Black button. The product aligns the cartridges. Recycle or discard the cartridge
alignment sheet.
Print a diagnostics page if the cartridges are not low on ink.
To print a diagnostics page
a.
Load letter or A4 unused plain white paper into the input tray.
b.
In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP
Deskjet 2520 series Toolbox.
c.
Click the Device Reports tab.
d.
Click Print Diagnostic Information to print a diagnostics page. Review the blue, magenta, yellow,
and black boxes on the diagnostics page. If you are seeing streaks in the color and black boxes, or no
ink in portions of the boxes, then automatically clean the cartridges

Solve a problem
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6.

Clean the print cartridges automatically, if the diagnostic page shows steaks or missing portions of the color
and black boxes.

Solve a problem

To clean the cartridges automatically
a.
Load letter or A4 unused plain white paper into the input tray.
b.
In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP
Deskjet 2520 series Toolbox.
c.
Click the Device Services tab.
d.
Click Clean Ink Cartridges. Follow the onscreen instructions.
If the above solutions do not resolve the problem, click here for more online troubleshooting.

Clear a paper jam
Clear a paper jam.
To clear a paper jam
1.
Locate the paper jam
Input tray
•
If the paper jam is located near the back input tray, pull the paper gently out of the input tray.
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Output tray
•
If the paper jam is located near the front output tray, pull the paper gently out of the output tray.

•

You may need to open the carriage door and slide the print carriage to the right to access the paper
jam.

Solve a problem

Inside of printer
•
If the paper jam is located inside the printer, open the cleanout door located on the bottom of the
printer. Press tabs on both sides of the cleanout door.

2.

•

Remove jammed paper.

•

Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.

Clear a paper jam
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If the above solutions do not resolve the problem, click here for more online troubleshooting.
Prevent paper jams
•
Do not overfill the input tray.
•
Remove printed papers from the output tray frequently.
•
Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
•
Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input
tray must be the same size and type.
•
Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width
guide does not bend the paper in the input tray.
•
Do not force paper too far forward in the input tray.
If the above solutions do not resolve the problem, click here for more online troubleshooting.

Unable to print
If you're having trouble printing, you can download the HP Printing Diagnostic Utility, which can troubleshoot this
issue for you automatically. To get the utility, click the appropriate link:
NOTE: The HP Printing Diagnostic Utility may not be available in all languages.
Take me to the HP Printing Diagnostic Utility download page.
Resolve print issues
NOTE: Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to
print, try the following in order:
Check for error messages and resolve.
Disconnect and reconnect the USB cable.
Verify that the product is not paused or offline.

4.

To verify that the product is not paused or offline
a.
Depending upon your operating system, do one of the following:
•
Windows 7: From the Windows Start menu, click Devices and Printers.
•
Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
•
Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.
b.
Either double-click the icon for your product or right-click the icon for your product and select See
what’s printing to open the print queue.
c.
On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer
Offline.
d.
If you made any changes, try to print again.
Verify that the product is set as the default printer.

Solve a problem

1.
2.
3.

To verify that the product is set as the default printer
a.
Depending upon your operating system, do one of the following:
•
Windows 7: From the Windows Start menu, click Devices and Printers.
•
Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
•
Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.
b.
Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.
c.
If the wrong product is set as the default printer, right-click the correct product and select Set as
Default Printer.
d.
Try using your product again.
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5.

Restart the print spooler.
To restart the print spooler
a.
Depending upon your operating system, do one of the following:
Windows 7
•
From the Windows Start menu, click Control Panel, System and Security, and then
Administrative Tools.
•
Double-click Services.
•
Right-click the Print Spooler, and then click Properties.
•
On the General tab, next to Startup type, make sure that Automatic is selected.
•
If the service is not already running, under Service status, click Start, and then click OK.
Windows Vista
•
From the Windows Start menu, click Control Panel, System and Maintenance,
Administrative Tools.
•
Double-click Services.
•
Right-click the Print Spooler service, and then click Properties.
•
On the General tab, next to Startup type, make sure that Automatic is selected.
•
If the service is not already running, under Service status, click Start, and then click OK.
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6.
7.

Windows XP
•
From the Windows Start menu, right click My Computer.
•
Click Manage, and then click Services and Applications.
•
Double-click Services, and then select Print Spooler.
•
Right-click Print Spooler, and click Restart to restart the service.
b.
Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.
c.
If the wrong product is set as the default printer, right-click the correct product and select Set as
Default Printer.
d.
Try using your product again.
Restart the computer.
Clear the print queue.
To clear the print queue
a.
Depending upon your operating system, do one of the following:
•
Windows 7: From the Windows Start menu, click Devices and Printers.
•
Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
•
Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.
b.
Double-click the icon for your product to open the print queue.
c.
On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to
confirm.
d.
If there are still documents in the queue, restart the computer and try printing again after the computer
has restarted.
e.
Check the print queue again to make sure it is clear, and then try to print again.
If the print queue is not clear, or if it is clear but jobs are still failing to print, proceed to the next
solution.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Unable to print
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Clear the print carriage
Remove any objects, such as paper, that are blocking the print carriage.
NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when removing
jammed paper from inside the product.
Click here to go online for more information.

Identify a defective cartridge
If both the tri-color and black ink level indicators are blinking, and the power light is on, both cartridges may still
have tape on, or are missing. First make sure that the pink tape has been removed from both cartridges, and that
both cartridges are installed. If both ink level indicators are still blinking, then one or both cartridges may be
defective. To determine if one cartridge is defective do the following:
1.
2.
3.

Remove black cartridge.
Close cartridge door.
If the Power light blinks, the tri-color cartridge should be replaced. If the On light does not blink, replace the
black cartridge.

Prepare the trays
Open output tray
▲ Output tray must be open to begin printing.

Solve a problem

Close cartridge door
▲ Cartridge door must be closed to begin printing.

Click here to go online for more information.
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Resolve copy and scan issues
Click here to go online for more information.

HP support
•
•
•
•

Register the product
Support process
HP support by phone
Additional warranty options

Register the product
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product
support alerts. If you did not register your printer while installing the software, you can register now at http://
www.register.hp.com.

If you have a problem, follow these steps:
1.
Check the documentation that came with the product.
2.
Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP
customers. It is the fastest source for up-to-date product information and expert assistance and includes the
following features:
•
Fast access to qualified online support specialists
•
Software and driver updates for the product
•
Valuable product and troubleshooting information for common problems
•
Proactive product updates, support alerts, and HP newsgrams that are available when you register the
product
3.
Call HP support. Support options and availability vary by product, country/region, and language.

HP support by phone
Phone support options and availability vary by product, country/region, and language.
This section contains the following topics:
•
•
•
•

Phone support period
Placing a call
Support phone numbers
After the phone support period

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To
determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support.
Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the product. Be prepared to provide the following
information:
•
•

Product name (located on product, such as HP Deskjet 2520 series)
Product number (located inside the cartridge access door)

HP support
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•
•
•

Serial number (located on the back or bottom of the product)
Messages that appear when the situation occurs
Answers to these questions:
◦
Has this situation happened before?
◦
Can you re-create it?
◦
Did you add any new hardware or software to your computer at about the time that this situation
began?
◦
Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

Support phone numbers
For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be available at the
HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for
your country/region to learn more about support options.
Solve a problem

Additional warranty options
Extended service plans are available for the HP Deskjet 2520 series at additional costs. Go to www.hp.com/
support, select your country/region and language, then explore the services and warranty area for information
about the extended service plans.
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Technical information
The technical specifications and international regulatory information for the HP Deskjet 2520 series are provided
in this section.
For additional specifications, see the printed documentation that came with the HP Deskjet 2520 series.
This section contains the following topics:
•
•
•
•

Notice
Specifications
Environmental product stewardship program
Regulatory notices

Notice

Specifications
Technical specifications for the HP Deskjet 2520 series are provided in this section. For more technical
specifications, see the Product Data Sheet at www.hp.com/support.
This section contains the following topics:
System requirements
Environmental specifications
Input tray capacity
Output tray capacity
Paper size
Paper weights
Print specifications
Copy specifications
Scan specifications
Print resolution
Power specifications
Cartridge yield
Acoustic information

Technical information

•
•
•
•
•
•
•
•
•
•
•
•
•

System requirements
For information about future operating system releases and support, visit the HP online support Web site at
www.hp.com/support.

Technical information
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Environmental specifications
•
Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)
•
Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)
•
Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
•
Non-operating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)
•
In the presence of high electromagnetic fields, it is possible the output from the HP Deskjet 2520 series may
be slightly distorted
•
HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise
due to potential high electromagnetic fields
Input tray capacity
Plain paper sheets (80 g/m2 [20lb]): Up to 50
Envelopes: Up to 5
Index cards: Up to 20
Photo paper sheets: Up to 20
Output tray capacity
Plain paper sheets (80 g/m2 [20lb]): Up to 30
Envelopes: Up to 5
Index cards: Up to 10
Photo paper sheets: Up to 10
Paper size
For a complete list of supported media sizes, see the printer software.
Paper weights
Plain Paper: 64 to 90 g/m² (16 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75 lb)

Technical information

Print specifications
•
Print speeds vary according to the complexity of the document
•
Method: drop-on-demand thermal inkjet
•
Language: PCL3 GUI
Copy specifications
•
Digital image processing
•
Copy speeds vary according to the complexity of the document and model
Scan specifications
•
Resolution: up to 1200 x 1200 ppi optical
For more information about ppi resolution, see the scanner software.
•
Color: 24-bit color, 8-bit grayscale (256 levels of gray)
•
Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)
Print resolution
Draft mode
•
Color Input/Black Render: 300x300dpi
•
Output (Black/Color): Automatic
Normal mode
•
Color Input/Black Render: 600x300dpi
•
Output (Black/Color): Automatic
40
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Plain-Best mode
•
Color Input/Black Render: 600x600dpi
•
Output: 600x1200dpi (Black), Automatic (Color)
Photo-Best mode
•
Color Input/Black Render: 600x600dpi
•
Output (Black/Color): Automatic
Max DPI mode
•
Color Input/Black Render: 1200x1200dpi
•
Output: Automatic (Black), 4800x1200 optimized dpi (Color)
Power specifications
0957-2286
•
Input voltage: 100-240Vac (+/- 10%)
•
Input frequency: 50/60 Hz (+/- 3Hz)
0957-2398
•
Input voltage: 100-240Vac (+/- 10%)
•
Input frequency: 50/60 Hz (+/- 3Hz)
0957-2290
•
Input voltage: 200-240Vac (+/- 10%)
•
Input frequency: 50/60 Hz (+/- 3Hz)
NOTE: Use only with the power adapter supplied by HP.
Cartridge yield
Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.
Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to: www.hp.com/support.

Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for
recycling has been incorporated into this product. The number of materials has been kept to a minimum while
ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily.
Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts
have been designed to access quickly for efficient disassembly and repair.
For more information, visit HP’s Commitment to the Environment Web site at:
www.hp.com/hpinfo/globalcitizenship/environment/index.html.
This section contains the following topics:
•
•
•
•
•
•
•
•
•
•
•

Eco-Tips
Paper use
Plastics
Material safety data sheets
Recycling program
HP inkjet supplies recycling program
Power consumption
Auto Power-Off
Sleep mode
Disposal of waste equipment by users in private households in the European Union
Chemical Substances

Environmental product stewardship program
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•
•

Toxic and hazardous substance table (China)
Restriction of hazardous substance (Ukraine)

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below
to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific
features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental
initiatives.
www.hp.com/hpinfo/globalcitizenship/environment/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify
plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and partners
with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling
some of its most popular products. For more information regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many
countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more
information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption
Technical information

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S.
Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Auto Power-Off
Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-Off is
enabled, the printer will automatically turn off after two hours of inactivity to help reduce energy use. You can
change the Auto Power-Off setting from the printer software. Once you change the setting, the printer will
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maintain the setting that you choose. Auto Power-Off turns the printer off completely, so you must use the
power button to turn the printer back on.
To enable or disable Auto Power-Off
1.
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.
NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series
2.
3.
4.

In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP Deskjet
2520 series Toolbox.
The HP Deskjet 2520 series Toolbox appears.
Click Advanced Settings. Follow the onscreen instructions.
TIP: If you are printing through a wireless or Ethernet connection over a network, Auto Power-Off should be
disabled to ensure that print jobs do not get lost. Even when Auto Power-Off is disabled, the printer enters a
Sleep mode after five minutes of inactivity to help reduce energy use.

Sleep mode
Power usage is reduced while in Sleep mode.
After initial setup of printer, the printer will enter Sleep mode after five minutes of inactivity.
The time to Sleep mode cannot be changed.
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•
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Disposal of waste equipment by users in private households in the European
Union
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Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our products as
needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.
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Toxic and hazardous substance table (China)

Restriction of hazardous substance (Ukraine)
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Regulatory notices
The HP Deskjet 2520 series meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:
•
•
•
•
•

Regulatory model identification number
FCC statement
Notice to users in Korea
VCCI (Class B) compliance statement for users in Japan
Notice to users in Japan about the power cord

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory
Model Number for your product is VCVRA-1221. This regulatory number should not be confused with the
marketing name (HP Deskjet Ink Advantage 2520hc All-In-One series, etc.) or product numbers (CX027A,
CX027B, etc.).

Regulatory notices
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Notice to users in Korea
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VCCI (Class B) compliance statement for users in Japan

Technical information

Notice to users in Japan about the power cord
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